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Resources 

4.1- Project Resources Overview: 

 

 Resources, within Microsoft Project, can be defined as the different people, equipment, materials, 

and costs used to complete the tasks within a given project file. Resources, therefore, can often be as 

varied as the tasks that they are required to complete within a given project. Generally, all projects need 

some people resources, and many projects also require the use of other equipment, cost, and material 

resources. Within Microsoft Project, you can create the various resources that you require in order to 

complete a project. You can assign costs to the resources, and also set a schedule of availability for your 

project file. This feature assists many project managers in tracking the time and cost constraints of their 

ongoing projects within an organization. In this chapter, you will learn how to create the various types of 

resources that are available within a project file: work resources (both people and equipment), material 

resources, and cost resources. 

 Note that you will now switch to a different working view when creating resources for your project 

file. For this chapter, you will be using the “Resource Sheet” view to create and manage your list of project 

resources. In order to use this view, open the desired project file and then click the “Resource Sheet” button 

in the project views button group located in the Status Bar. You can also select “Resource Sheet” from the 

drop-down button in the “View” group on the “Task” tab in the Ribbon. The view of the project will then 

switch to the “Resource Sheet” view, which is a table view that lists the various work, material, and cost 

resources used by the currently displayed project file. 

4.2- Creating Work Resources: 

 

 Since resources are used to track who and what was used in order to complete a given task in a 

project file, the first type of resource you will learn to create is also the most commonly used: the work 

resource. You create work resources to indicate who completes task work within a project file and what 

equipment they need to complete the task. Note that people resources can either be specific, such as a 

specific person with a unique or necessary skill that is required in order to accomplish a task (e.g. “John 

Doe”); or they can be general, such as the name of a general type of worker that is required in order to 

complete a task (e.g. “Electrician”). Either way, you enter the work resources, their availability, and their 

associated cost as a resource within your project file. In a later chapter, you will then learn how to assign 

these resources to tasks within a project- and let Microsoft Project schedule work assignments as needed. 

 First, switch the view of your project file to the “Resource Sheet” view in order to view and resources 

entered into the project file. This view allows you to enter, edit, and delete project resources. As when 

entering tasks, you have a couple of options as to the method that you use when entering project resources. 

One way is to simply click into the next available blank row in the Resource Sheet view, and then enter the 

desired resource information directly into the cells shown. Note that you must select the “Work” option from 

the “Type” column’s drop-down menu in order to classify this resource as a work resource. You can then 

enter any additional detail data that you would need to record for this resource. 

 Another way is to double-click the next available blank row or click into the next blank row and then 

click the “Resource Information” button that appears in the “Properties” button group on the “Resource” tab 

in the Ribbon in order to enter the resource details into the “Resource Information” dialog box that appears. 

  The “Resource Information” dialog box provides all of the available options for resource creation in 

Microsoft Project. First, enter a name for the resource into the “Resource Name:” field. You can also enter a 

group to which this resource belongs by typing your desired group into the “Group:” field. This allows you to 

sort and categorize resources. Next, select “Work” from the “Type:” drop-down to indicate that this is a work 

resource. You can enter any other desired project resource information into the “General” tab shown, and 

then click the “OK” button within the “Resource Information” dialog box in order to save the resource. 
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Resources 

4.3- Creating Material Resources: 

 

 Another type of resource that you can create for use within your projects is the material resource. In 

the previous lesson on creating work resources, note that you had to select the “Work” option from the 

“Type” drop-down for any work resources (people, places, or equipment) you created. Material resource 

types are different from work resources in that material resources represent material resources that are 

used or consumed by the various tasks within a project. For example, if you had “Paint walls” as a task 

within a project, it would make sense for you to create a work resource (e.g. “Painter”) and a material 

resource (e.g. “Paint”) that you could create in order to track the usage of that material within your project 

file. Also note that, unlike work resources, there are often many tasks that do not require material resources 

within a project file. However, the ability to track that type of information is available for users who do need 

to track material use, and often their associated costs, within their project files. 

 To create material resources within a project file, display the desired project file and then ensure that 

you are viewing the data in the “Resource Sheet” view. Next, enter the desired material resource information 

in the next blank resource row available. Be sure to select “Material” from the “Type” drop-down to indicate 

that this resource is a material resource. If you are using the “Resource Information” dialog box to enter your 

resources, you select the “Type” on the “General” tab. Also, if using the dialog box, be sure to click the “OK” 

button to save your data entry when you are finished to add the resource into the “Resource Sheet” view. In 

a later section within this chapter we will examine setting costs for these resources. 

4.4- Creating Cost Resources: 

 

 Another type of resource that you can create for use within your projects is the cost resource. Cost 

resources are different from work and material resources in that cost resources represent costs that are 

commonly incurred in order to complete various tasks within a project. For example, if you had “Client 

Meeting” as a task within a project, you may want to create a cost resource (e.g. “Travel”) in order to track 

the costs of travel associated with completing the client meeting tasks. Note that there are often many tasks 

that do not require cost resources within a project file. However, the ability to track that type of information is 

available for users who do need to track costs associated with completing tasks within their project files. 

 To create cost resources within a project file, display the desired project file and then ensure that you 

are viewing the data in the “Resource Sheet” view. Next, enter the desired cost resource information into the 

next blank resource row available. Be sure to select “Cost” from the “Type” drop-down to indicate that this 

resource is a cost resource. If you are using the “Resource Information” dialog box to enter your resources, 

you select the “Type” on the “General” tab. Also, if using the dialog box, be sure to click the “OK” button to 

save your data entry when you are finished to add the resource into the “Resource Sheet” view. 

 Another important difference between cost resources and work or material resources is that cost 

resources have no default cost or pay rate associated with their creation. In Microsoft Project, you only enter 

the cost of the resource when it is assigned to a task in the project. We will examine assigning resources to 

tasks in a later chapter. 

4.5- Entering Costs for Project Resources: 

 

 The work and material resource types that you have created in the previous lessons in this chapter 

can have default costs and/or pay rates associated with them. This assists you in recording the costs 

associated with completing your tasks. This information can help you keep your project within its financial 

constraints and help you improve your future estimates of costs involved with certain tasks in your projects. 
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Resources 

4.5- Entering Costs for Project Resources (cont.): 

 

 You can enter the default costing information of a resource directly in the “Resource Sheet” view of 

your project file. For work resources that are also people resources, you can enter their default pay rates 

into the “Std. Rate” and “Ovt. Rate” fields for the resources that appear in the “Resource Sheet” view in 

Microsoft Project. For material resources, you can enter a rate based on the use, or consumption, of the 

material resource. Many times, this information is entered into the “Cost/Use” field, although you can also 

specify a “Std. Rate” for material resources, if needed. Conversely, you can input a “Cost/Use” value for 

people resources, although this is less commonly used for people resources. 

 Also, if desired, you can select a resource from the Resource Sheet view and then click the 

“Resource Information” button in the “Properties” group on the “Resource” tab in the Ribbon in order to open 

the “Resource Information” dialog box. Within this dialog box, you can click the “Costs” tab in order to enter 

detailed costing information. 

 On the “Costs” tab, you can set detailed costing information that you cannot set by simply using the 

cells available in the “Resource Sheet” view. Also note that cost data cannot be set when initially creating 

the items within the “Resource Sheet” view. It can only be added after you have saved the resource into the 

resource sheet, as an “editing” task. 

 Note that on the “Costs” tab, you can enter the same rate information that you have available in the 

“Resource Sheet” view. However, you can also specify different rates based on different dates, by entering 

the date that the new rates are to take effect in the “Effective Date” column, and then entering the new rates 

as of that date. Also note that you are entering this information into tab “A” within the “Costs” tab. You 

should note that there are also four other tabs that you can use in order to enter different pay rates tables. 

The different pay rates shown on the different tables can then assist you in using different pay rates for 

different types of work that the work resource can perform. For example, a single work resource that earns 

one pay rate for “painting” and one for “roofing.” In this case, you can enter the two rates on these two tabs 

(A and B), and then switch the rate based on which type of task is being performed. 

 Also note that for costing data, you can indicate when you want the cost to be incurred by using the 

“Cost accrual” drop-down. This will tell Microsoft Project when to report the costs as being incurred for this 

resource. The default value is “prorated,” meaning the cost will be shown as the work is accomplished. 

However, you can also incur the entire cost at the “Start” or “End” of the assigned task. 

 Once you have set the desired costing data within the “Costs” tab of the “Resource Information” 

dialog box, be sure to click the “OK” button in the dialog box in order to save the changes. 

4.6- Scheduling Work Resources: 

 

 Once you have entered a work resource, you can adjust its working schedule so that Microsoft 

Project can then adjust the scheduling and use of the work resource, as needed. When you create a work 

resource in the “Resource Sheet” view, you can then set the default working calendar for the resource from 

the “Base Calendar” cell’s drop-down menu. In this lesson, we will examine making individual changes to 

the availability schedule of a work resource. 

 To do this, first select the row within the “Resource Sheet” view that contains the work resource 

whose availability schedule you wish to edit. Next, open the “Resource Information” dialog box by clicking 

the “Resource Information” button in the “Properties” group on the “Resource” tab in the Ribbon. In the 

“Resource Sheet” dialog box, click the “Change Working Time…” button on the “General” tab in order to 

open the “Change Working Time” dialog box. You can use this dialog box to make individual adjustments to 

the base work schedule calendar that has been selected. You can enter time off, vacation days, and other 

time that the resource will not be available to work during normally scheduled work hours by entering these 
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Resources 

4.6- Scheduling Work Resources (cont.): 

 

items into the “Exceptions” tab. If the resource has a set part-time availability, you can enter the schedule of 

their work week into the “Work Weeks” tab. 

 To create an exception to the work schedule, click the “Exceptions” tab. Here you can enter the 

various days off for the chosen work resource. To do this, you can click on the first day off shown in the 

calendar, if desired. Next, click into the first available blank row within the “Exceptions” tab and then type the 

name of the label that you want into the “Name” column. When you leave that cell, the date selected in the 

calendar above will be entered as the default values for both the “Start” and “Finish” dates of the time off. If 

this is incorrect, click into either or both the “Start” and “Finish” columns to indicate the correct start and end 

times of the “time off” from the project. You can then repeat this process, as needed, in order to enter any 

other time off for the selected work resource. 

 If you need to enter a custom work week for the selected resource, you can do that by clicking the 

“Work Weeks” tab within the “Change Working Time” dialog box. Note that the value of “Default” is shown 

within the first row of this tab. This value indicates that the default working time from the base calendar 

selected is to be used for task scheduling for this work resource. If you wish to change the default work 

schedule for this resource for all weeks in the project, you can select the “Default” row on this tab, first. If 

you only want to set a work schedule for a specified range of time, then click into the next blank row, 

instead. Then enter a name for the range of time into the “Name” column. You will then need to use the 

“Start” and “Finish” column’s drop-down arrow to set the start and end dates for the work schedule that you 

are about to specify. In this scenario, the work schedule that you are about to create will only be used during 

the dates selected. During dates that do not fall within this time, the default schedule will be used. 

 Next, for whichever schedule you are editing, click the “Details…” button in order to open the “Details 

for” dialog box. Here you can select the desired day or days of the week to edit by selecting them from the 

“Select day(s):” list at the left side of this dialog box. To the right of that area, you can then either select to 

“Set days to nonworking time,” or you can select “Set day(s) to these specific working times:” from the 

option buttons shown. Note that choosing the “Use time from base calendar for these days” does nothing to 

the scheduled days. If you selected the “Set days(s) to these specific working times” option, then set the 

available working hours for those days in the “From” and “To” columns below that area. Once you have 

finished creating your custom work schedule, click the “OK” button in the “Details for” dialog box until you 

return to the “Resource Information” dialog box. Click “OK” within the “Resource Information” dialog box in 

order to save the changes to the selected work resource’s schedule. 

4.7- Creating New Base Calendars: 

 

 As you saw in the previous lesson, you have the ability to edit the individual work availability 

schedules of selected work resources in your project file. These scheduling changes are made as 

deviations from a selected base calendar, such as the “Standard” calendar or the “Night Shift” calendar. 

These base calendars are the calendars that you select when initially creating your project file in order to 

choose a default work availability schedule for your project. Sometimes, you may need to create a new base 

calendar for ease of use within your project file. For example, you may choose to use the “Standard” 

calendar for your project file since the majority of your work resources will use that as their default work 

availability schedule. However, assume that you also used a pool of part time people (work resources) who 

only had a Monday, Wednesday, Friday 8AM to 5PM work schedule availability at all times. In this case, you 

may want to create a new base calendar that you can assign to each resource as they are entered into the 

“Resource Sheet,” so that you will not have to individually adjust each resource’s work schedule availability 

as we saw in the last lesson. This can be a real time saver, as you can select a base calendar directly from 
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Resources 

4.7- Creating New Base Calendars (cont.): 

 

the “Resource Sheet” view for any work resources that you enter. That way you won’t need to adjust each 

resource’s work schedule individually. 

 You can create a new base calendar by clicking the “Change Working Time” button in the 

“Properties” group on the “Project” tab in the Ribbon in order to open the “Change Working Time” dialog 

box. This dialog box allows you to change the working time for selected resources or change the default 

base calendar used for the current project, as well as create new base calendars. In order to create a new 

base calendar to use in your project, click the “Create New Calendar…” button that is shown within the 

dialog box. Doing this will open the “Create New Base Calendar” dialog box, where you enter the name that 

you want to give to this calendar into the “Name:” text box. You can select to either create an entirely new 

base calendar or you can select an existing base calendar to modify as the basis for your new base 

calendar. If you select choose to use a copy of another calendar as the basis of your new calendar, then 

select the name of the calendar to copy from the drop-down in this dialog box. When you have made your 

choices, click the “OK” button to continue. 

 In the “Change Working Time” dialog box, you are now viewing the base calendar that you have just 

created. You should see its name in the “For calendar” box at the top of this dialog box. Next, use the “Work 

Weeks” tab to set the new default work week schedule for this base calendar. You can also set any base 

days off on the “Exceptions” tab, if necessary. Once you have edited the work availability schedule for the 

calendar, click the “OK” button in the “Change Working Time” dialog box to save the new base calendar. At 

this point, you can then select the name of this calendar from the “Base Calendar” drop-down wherever that 

choice appears in your project file, such as within the “Resource Sheet” view. 
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ACTIONS- 

Resources 
SWITCHING TO RESOURCE SHEET VIEW: 

 

1. Click the “Resource Sheet” button in the project views button group located in the Status Bar. 

2. You can also select “Resource Sheet” from the drop-down button in the “View” group on the “Task” tab 

in the Ribbon. 

ENTERING WORK RESOURCES: 

 

1. Click into the next available blank row in the Resource Sheet view, and then enter the desired resource 

information directly into the cells shown. Note that you must select the “Work” option from the “Type” 

column’s drop-down menu in order to classify this resource as a work resource. You can then enter any 

additional detail data that you would need to record for this resource into the row. 

2. Another way is to double-click the next available blank row or click into the next blank row and then click 

the “Resource Information” button that appears in the “Properties” button group on the “Resource” tab in 

the Ribbon in order to enter the resource details into the “Resource Information” dialog box that 

appears. 

3. Enter a name for the resource into the “Resource Name:” field. 

4. You can also enter a group to which this resource belongs by typing your desired group into the 

“Group:” field. This allows you to sort and categorize resources. 

5. Select “Work” from the “Type:” drop-down to indicate that this is a work resource. 

6. You can enter any other desired project resource information into the “General” tab shown. 

7. Click the “OK” button within the “Resource Information” dialog box in order to save the resource. 

CREATING MATERIAL RESOURCES: 

 

1. To create material resources within a project file, display the desired project file and then ensure that 

you are viewing the data in the “Resource Sheet” view. 

2. Next, enter the desired material resource information in the next blank resource row available. Be sure 

to select “Material” from the “Type” drop-down to indicate that this resource is a material resource. 

3. If you are using the “Resource Information” dialog box to enter your resources, you select the “Material” 

choice for the “Type” on the “General” tab. Also, if using the dialog box, be sure to click the “OK” button 

to save your data entry when you are finished to add the resource into the “Resource Sheet” view. 

CREATING COST RESOURCES: 

 

1. To create cost resources within a project file, display the desired project file and then ensure that you 

are viewing the data in the “Resource Sheet” view. 

2. Next, enter the desired cost resource information into the next blank resource row available. Be sure to 

select “Cost” from the “Type” drop-down to indicate that this resource is a cost resource. 

3. If you are using the “Resource Information” dialog box to enter your resources, you select “Cost” from 

the “Type” drop-down on the “General” tab. Also, if using the dialog box, be sure to click the “OK” button 

to save your data entry when you are finished to add the resource into the “Resource Sheet” view. 
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ACTIONS- 

Resources 
ENTERING RESOURCE COSTS USING THE “RESOURCE INFORMATION” DIALOG BOX: 

 

1. You can enter the default costing information of a resource directly in the “Resource Sheet” view of your 

project file. 

2. For work resources that are also people resources, you can enter their default pay rates into the “Std. 

Rate” and “Ovt. Rate” fields for the resources that appear in the “Resource Sheet” view in Microsoft 

Project. 

3. For material resources, you can enter a rate based on the use, or consumption, of the material resource. 

Many times, this information is entered into the “Cost/Use” field, although you can also specify a “Std. 

Rate” for material resources, if needed. Conversely, you can input a “Cost/Use” value for people 

resources, although this is less commonly used for people resources. 

4. Also, if desired, you can select a resource from the Resource Sheet view and then click the “Resource 

Information” button in the “Properties” group on the “Resource” tab in the Ribbon in order to open the 

“Resource Information” dialog box. Within this dialog box, you can click the “Costs” tab in order to enter 

detailed costing information. 

5. On the “Costs” tab, you can set detailed costing information that you cannot set by simply using the cells 

available in the “Resource Sheet” view. Also note that cost data cannot be set when initially creating the 

items within the “Resource Sheet” view. It can only be added after you have saved the resource into the 

resource sheet, as an “editing” task. 

6. Note that on the “Costs” tab, you can enter the same rate information that you have available in the 

“Resource Sheet” view. However, you can also specify different rates based on different dates, by 

entering the date that the new rates are to take effect in the “Effective Date” column, and then entering 

the new rates as of that date. Also note that you are entering this information into tab “A” within the 

“Costs” tab. You should note that there are also four other tabs that you can use in order to enter 

different pay rates tables. The different pay rates shown on the different tables can then assist you in 

using different pay rates for different types of work that the work resource can perform. For example, a 

single work resource that earns one pay rate for “painting” and one for “roofing.” In this case, you can 

enter the two rates on these two tabs (A and B), and then switch the rate based on which type of task is 

being performed. 

7. Also note that for costing data, you can indicate when you want the cost to be incurred by using the 

“Cost accrual” drop-down. This will tell Microsoft Project when to report the costs as being incurred for 

this resource. The default value is “prorated,” meaning the cost will be shown as the work is 

accomplished. However, you can also incur the entire cost at the “Start” or “End” of the assigned task. 

8. Once you have set the desired costing data within the “Costs” tab of the “Resource Information” dialog 

box, be sure to click the “OK” button in the dialog box in order to save the changes. 
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ACTIONS- 

Resources 
SCHEDULING RESOURCES USING THE “RESOURCE INFORMATION” DIALOG BOX: 

 

1. Once you have entered a work resource, you can adjust its working schedule so that Microsoft Project 

can then adjust the scheduling and use of the work resource, as needed. When you create a work 

resource in the “Resource Sheet” view, you can then set the default working calendar for the resource 

from the “Base Calendar” cell’s drop-down menu. 

2. To do this, first select the row within the “Resource Sheet” view that contains the work resource whose 

availability schedule you wish to edit. 

3. Next, open the “Resource Information” dialog box by clicking the “Resource Information” button in the 

“Properties” group on the “Resource” tab in the Ribbon. 

4. In the “Resource Sheet” dialog box, click the “Change Working Time…” button on the “General” tab in 

order to open the “Change Working Time” dialog box. You can use this dialog box to make individual 

adjustments to the base work schedule calendar that has been selected. 

5. You can enter time off, vacation days, and other time that the resource will not be available to work 

during normally scheduled hours by entering these items into the “Exceptions” tab. If the resource has a 

set part-time availability, you can enter the schedule of their work week into the “Work Weeks” tab. 

6. To create an exception to the work schedule, click the “Exceptions” tab. Here you can enter the various 

days off for the chosen work resource. 

7. To do this, you can click on the first day off shown in the calendar, if desired. 

8. Next, click into the first available blank row within the “Exceptions” tab and then type the name of the 

label that you want into the “Name” column. When you leave that cell, the date selected in the calendar 

above will be entered as the default values for both the “Start” and “Finish” dates of the time off. 

9. If this is incorrect, click into either or both the “Start” and “Finish” columns to indicate the correct start 

and end times of the “time off” from the project. 

10. You can then repeat this process, as needed, to enter any other time off for the selected work resource. 

11. If you need to enter a custom work week for the selected resource, you can do that by clicking the “Work 

Weeks” tab within the “Change Working Time” dialog box. 

12. Note that the value of “Default” is shown within the first row of this tab. This value indicates that the 

default working time from the base calendar selected is to be used for task scheduling for this work 

resource. If you wish to change the default work schedule for this resource for all weeks in the project, 

you can select the “Default” row on this tab, first. If you only want to set a work schedule for a specified 

range of time, then click into the next blank row, instead. 

13. Then enter a name for the range of time into the “Name” column. You will then need to use the “Start” 

and “Finish” column’s drop-down arrow to set the start and end dates for the work schedule that you are 

about to specify. In this scenario, the work schedule that you are about to create will only be used during 

the dates selected. During dates that do not fall within this time, the default schedule will be used. 

14. Next, for whichever schedule you are editing, click the “Details…” button in order to open the “Details 

for” dialog box. Here you can select the desired day or days of the week to edit by selecting them from 

the “Select day(s):” list at the left side of this dialog box. To the right of that area, you can then either 

select to “Set days to nonworking time,” or you can select “Set day(s) to these specific working times:” 

from the option buttons shown. Note that choosing the “Use time from base calendar for these days” 

does nothing to the scheduled days. If you selected the “Set days(s) to these specific working times” 

option, then set the available hours for those days in the “From” and “To” columns below that area. 

15. Once you have finished creating your custom work schedule, click the “OK” button in the “Details for” 

dialog box until you return to the “Resource Information” dialog box. 

16. Click “OK” within the “Resource Information” dialog box in order to save the changes to the selected 

work resource’s schedule. 
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ACTIONS- 

Resources 
CREATING A NEW BASE CALENDAR: 

 

1. You can create a new base calendar by clicking the “Change Working Time” button in the “Properties” 

group on the “Project” tab in the Ribbon in order to open the “Change Working Time” dialog box. This 

dialog box allows you to change the working time for selected resources or change the default base 

calendar used for the current project, as well as create new base calendars. 

2. In order to create a new base calendar to use in your project, click the “Create New Calendar…” button 

that is shown within the dialog box. 

3. Doing this will open the “Create New Base Calendar” dialog box, where you enter the name that you 

want to give to this calendar into the “Name:” text box. 

4. You can select to either create an entirely new base calendar or you can select an existing base 

calendar to modify as the basis for your new base calendar. If you select choose to use a copy of 

another calendar as the basis of your new calendar, then select the name of the calendar to copy from 

the drop-down in this dialog box. When you have made your choices, click the “OK” button to continue. 

5. In the “Change Working Time” dialog box, you are now viewing the base calendar that you have just 

created. You should see its name in the “For calendar” box at the top of this dialog box. 

6. Next, use the “Work Weeks” tab to set the new default work week schedule for this base calendar. 

7. You can also set any base days off on the “Exceptions” tab, if necessary. 

8. Once you have edited the work availability schedule for the calendar, click the “OK” button in the 

“Change Working Time” dialog box to save the new base calendar. 

9. At this point, you can then select the name of this calendar from the “Base Calendar” drop-down 

wherever that choice appears in your project file, such as within the “Resource Sheet” view. 
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EXERCISES- 

Resources 
Purpose: 

 

1. To be able to create basic resources within a project file using Microsoft Office Project. 

Exercises: 

 

1. Open the “My Project” project file that contains the saved changes that were made to the file through 

the end of the previous chapter’s exercises. 

2. Click the “Resource Sheet” button in the “Views Button Group” shown in the lower-right corner of the 

Status Bar to display the “Resource Sheet” view for the “My Project” project file. 

3. Enter the following data into the “Resource Sheet” view. 

 

 

 

 

 

 

 

 

4. Click the “Save” button within the Quick Access toolbar to save your changes when you are finished. 

5. Click the “Project” tab in the Ribbon, and then click the “Change Working Time” button in the 

“Properties” button group in order to open the “Change Working Time” dialog box for the project file. 

6. Click the “Create New Calendar…” button within the “Change Working Time” dialog box in order to 

open the “Create New Base Calendar” dialog box. 

7. Type “Part Time” into the “Name:” field within the “Create New Base Calendar” dialog box. 

8. Select the “Make a copy of” option button, and then choose the “Standard” choice from the adjacent 

drop-down menu. 

9. Click the “OK” button when you are finished to display the new working calendar within the “Change 

Working Time” dialog box. 

10. Click the “Work Weeks” tab within the “Change Working Time” dialog box, and then select the 

“[Default]” choice within the tab. 

11. Click the “Details…” button to the right of the “Work Weeks” tab with the “[Default]” choice selected 

in order to open the “Details for [Default]” dialog box. 

12. Select “Tuesday” in the “Select day(s):” list, and then select the “Set days to nonworking time” option 

to the right of that day. 

13. Select “Thursday” in the “Select day(s):” list, and then select the “Set days to nonworking time” 

option to the right of that day. 

14. Click the “OK” button within the “Details for [Default]” dialog box. 

15. Click the “OK” button within the “Change Working Time” dialog box to save your new calendar. 

16. Select the new “Part Time” choice from the drop-down that appears when you click into the “Base 

Calendar” column for resource number 3 (Writers- Part Time) within the Resource Sheet. Be sure to 

exit the cell to save your change after making your selection from the drop-down. 

17. Click the “Save” button within the Quick Access toolbar to save your changes when you are finished. 

18. Click the “x” in the upper-right corner of the project file window to close the sample project file that 

you just saved. You will continue to use this file to complete the upcoming sequential 

exercises throughout this entire course. Each exercise builds upon the previous exercise, so 

please complete them in the order given to maximize your overall learning experience. 
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